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Introduction to the Smart Alec software

 

Installing Smart Alec software

 

To install the Smart Alec system, insert the Smart 
Alec CD in your CD drive. The Smart Alec installation 
process will start automatically. Simply follow the 
on-screen instructions.

 

NOTE:

 

If the Smart Alec installation process does not 
start automatically, you can start it manually:

1. Select 

 

Start > Run…

 

 

2. Type 

 

setup.exe

 

3. Click 

 

OK

 

NOTE:

 

If you already have Smart Alec installed on the 
computer, this version of Smart Alec will not 
install. Please contact Adaptive Micro Systems’ 
Technical Support department at 
1-800-558-7022 for assistance.

 

NOTE:

 

If you are installing on a computer with 
Windows 98, after the Data Access installation, 
you will be prompted to restart the computer. 
Do not restart at this time. Instead, click 

 

Exit 
Setup

 

 and allow the Smart Alec installation to 
complete. When complete, you will again be 
prompted to restart the computer. Do so at this 
time.

 

NOTE:

 

If you click 

 

Cancel

 

 at the Smart Alec 
Registration Information screen, the Smart 
Alec files will remain on the computer.
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Overview

 

Smart Alec is a software system that integrates data 
from many sources, and sends that data to ALPHA 
electronic signs, alphanumeric pagers, and email 
systems.

 

Input vs. output

 

Data can come from many sources and can be in a 
variety of formats. This data can be placed into messages 
which can be sent to a number of viewing destinations. 
These destinations are called “notification devices.” 
Messages can be sent to the notification devices in a 
number of ways. 

 

Setup vs. management

 

Normally the applications that are needed to set up 
the Smart Alec system are available only to an 
administrator, while the applications needed for routine 
management of messaging needs are available to all 
users. In an environment where only one person is 
responsible for using Smart Alec, this user is also the 
administrator, with full access to all applications.

 

System security

 

Security for Smart Alec is available to be able to limit 
access to some features or functions. This security applies 
to Smart Alec applications and what users can do with 
the applications, either read-only (“Details”) or both read 
and update (“Update”) access. Security also applies to 
system resources, such as hardware and data. A user will 
be able to use an application or resource only if he has 
authorization greater than or equal to the level 
determined to be needed for that application or resource. 
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Administrator vs. user security

 

Security is available so that, for instance, applications 
needed only by the Smart Alec administrator (to set up 
the system) are not accessible by normal users (for 
general management of the system.)

 

Single-user vs. multi-user environments

 

A “single-user” environment in Smart Alec might 
have more than one user, but all users have full access 
rights to all applications, application functions, and 
system inputs and resources. A “multi-user” 
environment is appropriate when users should not 
necessarily have access to the same applications and 
application functions; that is, access can be restricted for 
some users for applications, application functions, or 
system inputs or resources. For example, you may want 
to restrict a clerk’s authority and not allow that person to 
send messages to the signs on the production floor. But 
you would want the building security manager to be able 
to send a fire alarm to every sign. Also, you might not 
want either of these people to be able to set authority for 
other users.
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Smart Alec applications

 

The applications (programs) available in Smart Alec 
and their respective functions are as follows:

 

SA Bar

 

The initial Smart Alec application from which you 
can start any other Smart Alec application for which you 
are authorized.

 

Notification Device Setup

 

Designate the names and properties to be used for 
places where messages will be displayed (i.e., signs, 
pagers, and email.)

 

Notification Device Group Manager

 

Designate groups of notification devices so a user 
can send a message to multiple devices simultaneously.

 

Notification Device Interface Setup

 

Designate the type of hardware the computer uses to 
send messages to notification devices. See “Appendix 3: 
Notification Device Interfaces” on page 96 for 
descriptions and examples.

 

Variable Setup

 

Designate variables to be available in Smart Alec.
Variables represent values that can change at any 

time. When there is a change in a variable’s value, actions 
set up in Variable Rule Manager (see below) can be 
triggered.

 

Variable Rule Manager

 

Designate rules to govern variables, what is done 
with them, and what happens when their values change.

A rule is a pre-defined set of one or more conditions 
with possible resulting actions. A rule is associated with 
a variable and is implemented when the value of that 
variable changes. When the rule is implemented, its 
conditions are evaluated. Based on the result of that 
evaluation, the rule’s resulting actions may be initiated. 
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User Account Security Setup

 

Designate what level of authorization is granted to 
any user for applications, variables, commands, and 
notification devices. In other words, you decide if users 
can access a given resource (application, notification 
device, etc.) and what functions they can do with it.

 

Application Security Setup

 

Designate what level of authorization is needed by 
any user to access specific applications and the functions 
in each. If the level of authorization assigned to a user is 
greater than or equal to the level of authorization 
needed, then access is granted.

 

Message Manager

 

Define messages which can be displayed on 
notification devices. Messages can include text, graphics, 
formatting, time, date, temperature, variables, and 
animation.

 

Command Manager

 

Designate commands which are used to add, delete, 
erase, or replace messages. Commands can be scheduled 
for a specific date and time or for a recurring time period.

 

DDE Data Source Setup

 

Designate what data will be coming from outside of 
Smart Alec using DDE (Dynamic Data Exchange), where 
it will come from, and what to do with it. This data will 
be used to provide the values for variables.

 

Socket Handler Setup

 

Set a user-defined port number to use as a socket to 
receive data from an external system.

 

Event Log Manager

 

View a log of all events that occur in Smart Alec.

 

Event Log Acknowledgement

 

Some of the events that occur in the Smart Alec 
system may be serious enough that someone should 
review them and decide if something should be done 
about them. Smart Alec identifies these events and 
allows a user to acknowledge having seen them by using 
the 

 

Event Log Acknowledgement

 

 application.
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Smart Alec Shutdown

 

Closes all of the Smart Alec applications that do the 
background processing.
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Smart Alec basics

 

Starting the Smart Alec system

 

Logging into Smart Alec

 

To log into the Smart Alec system:
1. From the 

 

Start

 

 button, click 

 

Programs

 

 > 

 

Smart 
Alec

 

.
2. The Smart Alec introductory splash screen will 

appear temporarily.
3. Next, the 

 

Login 

 

screen will appear, as below. 

4. Type in your name and password, and click on 
the 

 

Login

 

 button.
5. Processing applications are started and run in 

the background as needed.

 

NOTE:

 

Even if you click 

 

Cancel

 

 in Step 3 above, the 
processing applications remain running. To 
shut them down, log into Smart Alec and click 
Smart Alec Shutdown on the SA Bar. 

 

NOTE:

 

While using the system, if Smart Alec does not 
seem to be processing, see “Appendix 1: 
Troubleshooting” on page 93.

6. Also, the window called the SA Bar will appear 
for your use. (See “Using the SA Bar” below.)

NOTE
If you are the first or only person 
logging into the system, or if 
you are the administrator, accept 
“Alec” as the user name with no 
password.
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Using the 

 

SA Bar

 

The 

 

SA Bar

 

 is where you start all the Smart Alec 
applications for which you are authorized. 

 

How to use the SA Bar

 

• Click on any of the button group bars to show 
the applications available within that group of 
applications. The button group bars slide up and 
down as needed to reveal component 
applications below each bar.

• Click once on any application to start that 
application.

• Use the close button to close any currently-
running Smart Alec user applications in addition 
to closing the SA Bar. See “Shutting the Smart 
Alec system down” on page 10.

 

Smart Alec applications in button group bars

 

Security Setup

 

• User Account Security Setup
• Application Security Setup

 

System Resource Setup

 

• Notification Device Interface Setup
• Notification Device Setup
• Variable Setup
• DDE Data Source Setup
• Socket Handler Setup

Button group bars

Authorized 
applications

Close button
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• Command Manager 
• Message Manager

 

System Resource Setup

 

• Variable Rule Manager
• Notification Device Group Manager
• Display Command Group Manager

 

Event Log

 

• Event Log Acknowledgement
• Event Log Manager

 

Startup/Shutdown

 

• Smart Alec Shutdown
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Shutting the Smart Alec system down

 

Individual applications

 

To close any individual user application for setup 
and management of the system, use any of these 
methods:

• Click the close button, available for all Smart 
Alec applications. 

• Choose 

 

Exit

 

 from the application’s 

 

File

 

 menu.
• Press Alt+F4.

 

All background processor applications

 

To close all of the Smart Alec applications that do the 
background processing, click Smart Alec Shutdown on 
the SA Bar. (You can see which programs are running in 
Windows by pressing Ctrl/Alt/Del together. Be sure to 
choose 

 

Cancel

 

 here rather than 

 

End Task

 

 or 

 

Shut Down.

 

)

 

NOTE:

 

Running Smart Alec Shutdown will stop all 
processing of messages and commands!

To restart the background processors, from the 

 

Start

 

 
button, click 

 

Programs

 

 > 

 

Smart Alec

 

. 

Close
button

User Security 
File menu
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All setup and manager applications

 

To close all of the currently-running Smart Alec user 
applications for setup and management of the system 
(found in the SA Bar), close the SA Bar by either of the 
following methods.

 

NOTE:

 

This will 

 

not

 

 close the Smart Alec background 
processor applications. (See the prior section.)

• Choose 

 

Close

 

 on the SA Bar menu.
• Click the close button on the SA Bar.
• Press Alt+F4.

 

Complete Smart Alec system

 

1. Click Smart Alec Shutdown on the SA Bar.
2. Close the SA Bar.

Close 
button

SA Bar menu button
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Security authorization

 

Security concepts

 

Smart Alec security is used to permit or deny access 
to applications, functions, and system resources in order 
to separate administrative and setup functions from 
general management functions.

Security is set up such that there are levels for 
authority from 1 (greatest authority) to 99 (least 
authority). That is, the lower the number, the more 
authority you have, up to the point of your being 
“number 1.”

The security level is set for each user to determine 
how much authority the user is granted to access 
applications, functions, and system resources. The 
security level is also set for each application/function 
and system resource to determine the minimum 
authority needed for a user to access them. If a user’s 
authorization level is greater than or equal to the 
minimum needed for that application/function or 
system resource, then access is granted to that user. 

Example 1
User can access the 
system resource

Authority 
granted = 5

Authority needed 
(minimum) = 75

User security 
authority

Security authority 
needed

1

99
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Where security is used

 

The security system is used for:
• create and use system resources (i.e., notification 

devices, variables, commands)
• use applications (programs to run, some of 

which can create, authorize, or change system 
resources)

• use application functions (view details, make 
updates)

Example 2
User can access the 
system resource

Authority 
granted = 50

Authority needed 
(minimum) = 50

User security 
authority

Security authority 
needed

1

99

Example 3
User can not access 
the system resource

Authority 
granted = 75

Authority needed 
(minimum) = 5

User security 
authority

Security authority 
needed

1

99
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Security system controls

Applications

 

• If you have enough “details” authorization to 
use an application, that application will appear 
in the SA Bar for you. You will be able to use that 
application and view details of any data in it.

• If you have enough “update” authorization for 
an application, that application will also appear 
in the SA Bar for you. You will be able to view 
details and, in addition, you will be able to make 
changes using that application.

 

Resources

 

• Some applications can create and manage system 
resources. If you have sufficient “details” 
authorization for a system resource, you will be 
able to view details of any system resource data.

• For system resource applications, if you have 
sufficient “update” authorization, you will be 
able to view details and, in addition, you will be 
able to make changes to system resources.

 

Data

 

• Some applications can create data that can be 
designated as public or private. Each user who 
creates data in one of these applications 
determines whether that data is to be available to 
other users (public) or to only himself (private) 
when anyone is using that application. Then 
when that application is to present data to any 
user, the application checks to see if the data 
requested is for public use or only for private 
use. If the user is the creator of the data or if the 
data is for public use, the data is displayed. 
Otherwise, it is not.

 

Processing

 

• Similar to data, processing (display) commands 
can be designated as public or private.
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Given all the above points, it is possible to have 
authorization to access an application for a specific 
system resource and to create one of those system 
resources, but not have enough authorization to use that 
system resource. For example, you could be authorized 
to use Notification Device Setup to initialize a new 
notification device, but not be authorized in Notification 
Device Group Manager to group that new notification 
device with others.

 

Classes of users

 

While security is set up such that there are levels of 
authority from 1 (greatest authority) to 99 (least 
authority), it is easiest to work with just a few levels. A 
level of 50 has been established for a general level user, 
while a level of 5 has been established for an 
administrative level user. Any other levels are acceptable 
for customized users, but 25 and 75 might be good 
choices because they are easy to use.

See “Creating user environments” on page 28 for 
detailed instructions for setting up individual users.

 

General user: lower authorization, discretionarily set by system 
administrator

 

The default authorizations for a general user are as 
follows. These authorizations give normal access for 
applications and system resources for routine 
management of the system. This is how all users are 
initially set up in Smart Alec for all applications and 
system resources. Notice that all authorization level 
values are the same and therefore, all users have the 
same system access. 

 

Type of authorization Scope of authorization
Authorization 

level

 

Application Applications–full access

 

50

 

Application Applications–details access

 

50

 

Processing Commands

 

50

 

System resource Notification Devices

 

50

 

System resource Variables

 

50
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Administrative user: greater authorization, discretionarily set by system 
administrator

 

The default authorizations for an administrative user 
(such as “Alec”) are as follows. These authorizations give 
high-level administrative access to set up applications 
and system resources. 

Custom user: uniquely set up as needed
Authorizations for a custom user vary according to 

an individual’s need to access applications and system 
resources. Great care must be taken when setting up 
custom user authorizations and matching them with the 
settings for applications and system resources. 
Otherwise, some users may be inadvertently denied 
access.

The following is an example of one possible way to 
create another class of user.  

This example gives limited access to variables and to 
update (“full access”) applications, gives broad access to 
view details in applications, and gives normal access to 
commands and notification devices.

Type of authorization Scope of authorization
Authorization 

level

Application Applications–full access 5

Application Applications–details access 5

Processing Commands 5

System resource Notification Devices 5

System resource Variables 5

Type of authorization Scope of authorization
Authorization 

level

Application Applications–full access 75

Application Applications–details access 25

Processing Commands 50

System resource Notification Devices 50

System resource Variables 75
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Setting minimum security levels for applications and system resources

Security levels authorized for users work together 
with security levels for applications and system 
resources. Authorization levels are set for each user for 
applications in general, as shown above. In addition, 
minimum authorization levels are set for each specific 
application. If a user’s authorization range is greater than 
or equal to the minimum needed for an application, then 
access is granted to that user. 

Normally, default authorization levels for both users 
and applications are set to 50. However, in the Smart Alec 
system with the custom user illustrated above, 
application security could be set up with these settings 
for the applications shown here: 

In this example, a high level of authority is needed to 
gain access to Application Security Setup and User 
Account Security Setup. The user in this example does 
not have that level of authority. So these applications 
would not appear in the SA Bar for him. But he does 
have sufficient authority for full (update) access to 
Notification Device Group Manager and for details 
(read) access to both Notification Device Setup and 
Variable Rule Manager. Therefore, he would be able to 
make updates in Notification Device Group Manager, 
and he would be able to see details but not make updates 
in Notification Device Setup and Variable Rule Manager.

See “Authorizing applications and application 
functions” on page 34 for detailed instructions.

Specific application
Minimum 

authorization 
level needed

Application Security Setup 5

User Account Security Setup 5

Notification Device Setup 50

Notification Device Group Manager 75

Variable Rule Manager 50
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How Smart Alec uses variables

Variable Setup is used to identify variables to be used 
in Smart Alec. Variables represent values that can change 
at any time. The values can come from a number of 
places, such as a production line, a spreadsheet, and 
others. Some examples of variables are temperature or 
production rates, alarms, and security lock status. (See 
“Identifying variables” on page 50 for detailed 
instructions.)

Various rules (pre-defined conditions with resulting 
actions) govern variables, what is done with them, and 
what happens when their values change.

Smart Alec constantly monitors variables for a 
change in their values. When there is a change, any rule 
associated with that variable will be analyzed and its 
actions may be triggered. Examples of possible actions 
include starting or stopping a message, updating the 
value of a variable if it is included in any message, and 
setting off an alarm. (See “Using variable rules” on 
page 80 for detailed instructions.)

One of the most important concepts to understand is that 
you can use variables and variable rules to control things that 
happen in Smart Alec. Both a variable and a rule defining it or 
controlling the results of a change in its value can execute an 
action in Smart Alec.

Types of variable rules

There are three types of rules for variables.
• Counter Rule – A rule to define a variable and its 

appearance when it’s displayed (e.g., what color, 
flashing or not). When there is a change in the 
value of the variable, the counter rule is used to 
update the variable’s value (“counter”) on a 

SALES NEWS
Sales today: $12,345

In this example, the amount of 
sales (12,345) is the variable.
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notification device where the variable is part of 
an active message.

• Counter Rule with Alarm – A rule to define a 
variable and to set high and low thresholds for a 
variable in addition to a normal range. When 
there is a change in the value of the variable, the 
counter with alarm rule is used to update the 
variable’s value (“counter”) on a notification 
device where the variable is part of an active 
message. If the value goes outside either the high 
or low threshold, it will be displayed with a 
different appearance from the normal way it’s 
displayed (e.g., color, flashing or not.) Only 
works on variables used in a message, not the 
text.

• Display Command Rule – A rule to identify 
variables to use as tools to trigger display 
commands, which, in turn, trigger actions, such 
as displaying a message, based on comparing the 
value of a variable with another value. This rule 
is in the format of:

If <value1> compares favorably to 
<criteria1>,

(and/or <value2> compares favorably to 
<criteria2>)

then do <display command>.
Examples:
1. If temperature of machine >= 212°, then 

display the “temperature alarm” message.
2. If counter = 1000, then display the 

“production goal” message.
3. If sales >= 1000 and net profit >= 1 million , 

then display the “congratulations” message.
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How the Smart Alec windows work

The picture below is representative of the windows 
in Smart Alec. The table following indicates its features 
and functions.

Duplicate, Update, Details, and Delete are described 
generically below. The New Item function is described in 
general below, and is described in detail individually in 
the section for each Smart Alec application. 

Feature Name Function

A Menu button Pull-down menu for the application.
B New item Create a new item of this type. The properties will need to be filled in.
C Duplicate this item Duplicate the item selected and show its properties so they can be changed 

as needed to create another item that is similar to the original.
D Update this item Show all properties for this item so they can be updated as needed. You can 

also access the screen to update an item by double-clicking to the left of the 
row. (See L.)

E Details Show all properties for this item, but do not allow any updating.
F Delete this item Delete this item from Smart Alec.
G What’s this button After you click on another section of the window, information about that 

section will be displayed. Not in effect in Smart Alec at this time.
H Search function Use this after selecting a column to search for a specific value.
I Minimize button Put the application down to the Windows task bar.
J Resize button Toggle the size of the window.
K Close button Close this application.
L Item selection Click in this column to select an item or double-click to open it. (See D.)

A B C D E F G H I J K

L

M

N

O
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The picture below is representative of the add/
update/details windows in Smart Alec. The table 
following indicates its features and functions.

 

M Right-click Right-click on the name of the item to show properties and allow updating.
N Row height Click and drag the bottom edge of the row to adjust the height of the row.
O Column width Click and drag the right edge of the column to adjust the width of the column.

Feature Name Description

A Item name Name of the item selected. Cannot be changed after the item is created. If 
you need to change it: duplicate the item, change the new item’s name, 
then delete the original item.

B Item properties Must be added, can be updated with proper authorization, can not be 
updated in details mode.

C Drop-down selection Allows selection of items already created.
D Add/Update Adds or updates this one item and exits this window.
E Apply Allows you to save the values for this item and then view/update the 

values for any other item of the same type.
F Cancel Exits this window without making any changes.

Feature Name Function

A

C

D E F

B
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Working with Smart Alec application components

The functions for Duplicate, Update, Details, and 
Delete are similar in each Smart Alec application. This 
section describes these functions generically, but uses the 
Variable Rule Manager as an example for the application 
items.

Where an application’s function differs from these 
generic functions, it is described in a section for that 
application. The function for Add is described for each 
application and gives explanations for all properties for 
the item being added.

Duplicating an item
You can duplicate any item and change the name and 

any properties. 
1. Highlight the row for the item to copy. Then 

either choose File > Duplicate or click the 
Duplicate button. 

NOTE
Since you can’t change the name 
of an item with the Update 
function, use duplicating to 
rename an item:
1. Create a copy.
2. Rename it.
3. Delete the original.

Click in this column to 
select an item.

Duplicate button
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2. The window for adding an item will appear. 
Change the name of the item and any properties 
that are different. Then click either Add or Apply. 

3. Clicking the Add button takes you out of the 
window for adding an item, and the new item is 
shown in the list. Clicking the Apply button adds 
the new item into the list, but you won’t see that 
until you exit the window for adding an item, 
with either Add or Cancel. 

NOTE: In the Variable Rule 
Manager, the Add Rule window 
used depends on the type of 
rule to copy. 
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Changing an item
1. Highlight the row for the item to change. Then 

either choose File > Update or click the Update 
button. 

2. Make your changes. Then click Update. 

Click in this 
column to select 
an item.

Update button

You can not change the item’s Name here. 
You can change anything else.

You can change more than one item in sequence this way:
1. Make the changes in the first item.
2. Click Apply.
3. Choose another item using the name drop-down arrow.
4. Make changes in the new item.
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Viewing details of an item
1. In the far left column, highlight the entire row for 

the item for which you wish to view details. 

2. From the File menu, choose Details, or click on 
this:

3. The Details screen will appear. This simply 
shows the settings for the item. You can not 
change any of the settings here. 

4. You can choose another item using the name 
drop-down arrow. 

Click in this column 
to select an item.

Details button
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Deleting an item
1. In the far left column, highlight the entire row for 

the item you wish to delete from the system. 

2. From the File menu, choose Delete, or click on 
this:

3. You will be asked if you want to delete this item.
4. Choose Yes to delete the item.

Click in this column to 
select an item.

Delete button
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Setting up the Smart Alec system

Overview

Typically, Smart Alec is used by only one person in 
an organization. Even if there is more than one person 
using Smart Alec, all users can be set up to have full 
access rights to all applications, application functions, 
and system inputs and resources. This setup is called a 
“single-user” system.

However, if there is more than one person using 
Smart Alec, your system may require security to be set so 
some users have unlimited usage and others have limited 
usage of Smart Alec. This setup is called a “multi-user” 
system. In a multi-user system, those users with limited 
usage of Smart Alec generally can only access 
applications for managing the system, not those for 
setting up the system.

Setting up the Smart Alec software

A number of things must be set up in the Smart Alec 
environment for first-time use:

• Create user environments.
• Authorize applications and application 

functions.
• Identify system resources (notification device 

interfaces, notification devices, variables.)
• Establish input data sources, such as DDE or 

sockets.

NOTE
Default settings are provided for 
each user, application, or 
resource.
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Creating user environments

The Smart Alec system is designed so that it can be 
used by many different people in a company in different 
ways. The purpose of User Account Security Setup is to 
establish users and to assign levels of authorization to 
any user for applications, variables, commands, and 
notification devices. In other words, you decide if users 
can access a given resource (application, device, etc.) and 
what functions they can do with it.

In a multi-user environment, some people may need 
to have different access to various applications. For 
example, an administrator will need to have full access to 
all applications, while regular users might have access to 
only a few applications that they use. The Smart Alec 
security system allows users who have sufficient access 
authorization for applications to create, update and 
delete users.

However, in a single-user environment, you only 
need to establish who the users are. All users have the 
same access to all system resources, so there is minimal 
setup for users.

Accessing the User Account Security Setup application

From the Security Setup group on the SA Bar, click 
once on User Account Security Setup. A screen like the one 
shown below will appear, listing any existing users.
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Setting up a user

In the user security screen, each row shows all the 
security authorizations for a given user. 

• Select a user by clicking to the left of the row 
once. 

• Add a new user by clicking the New User button.
• View, duplicate, update, or delete the chosen 

user by using the buttons on the toolbar or from 
the drop-down File menu.

• You can also access the screen to update a user 
by double-clicking to the left of the row.

The Smart Alec system comes installed with a default 
user of “Alec” so you can access the system immediately 
as user “Alec”. “Alec” has no password assigned. You 
can keep the user as “Alec,” or you can change the name 
or authorization of this user as desired.

Default Authorizations

The default authorization for applications and 
system resources for user “Alec” is 5. These 
authorizations give high-level administrative access.

The default authorization for applications and 
system resources for any other user is 50. These 
authorizations give normal access. In a single-user 
environment, you should not change this setting.

New user

Duplicate this user Update this user

Delete this user

Select a user by clicking here.
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See “Security authorization” on page 12 for a 
conceptual understanding.

Adding a user

To add a new user, do the following:
1. From the File menu, choose New, or click on this 

button:

2. Fill in the values as appropriate for the new user.

Item Name Description

A User name Name by which this user is known.
B Password For security, a set of characters to be entered by the user when logging 

into the system. May be left blank, if desired, except that, to use the Socket 
Handler Setup (see page 56) there must be a password.

C Application 
Authorizations and 
levels

System processors validate requests against the level authorized for the 
user. If the user’s level of authorization is equal to or higher than that 
required, the request is processed. These are set to a default of 50. In a 
single-user environment, these should not be changed from 50. In a multi-
user environment, these are normally set to either 5 (administrator) or 50 
(general), but they can be set to any desired level.

A

B

C



Creating user environments

31

NOTE: For better understanding, see “System 
security” on page 2 and “Security 
authorization” on page 12.

Authorizing user passwords

User-authorized password
You, as a user, can add or change your own 

password at the Login screen.
1. When logging into Smart Alec, click Change 

Password.

2. If there was an existing password, you must type 
that in. Then type the new password, and retype 
it again exactly the same way. You can use a new 
password, as shown below, or you can use a 
blank password for New Password. Using a blank 
new password, in effect, deletes any old 
password.

3. Click Change.
4. You will next be logged into Smart Alec.
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Administrator-authorized password
The administrator can add or change the password 

for a user.
1. From the User Account Security Setup and Security 

application, highlight the entire row for the user 
by clicking in the column to the left of that user. 

2. From the File menu, choose Update, or click on 
this:

3. Click New Password.

4. Type in the new password and click Ok. 
Regardless of what the old password was, the 

Click in this column 
to select a user.

Update button
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default password supplied is “smartalec”. You 
can use “smartalec” (as shown below,) you can 
use a different password, or you can use a blank 
password. Using a blank password here, in 
effect, deletes any old password. 

5. Click Update.
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Authorizing applications and application functions

The purpose of Application Security Setup is to 
designate what level of authorization is needed by users 
to access specific applications and the functions in each.

In a single-user environment, all users have the same 
access authority for all application categories and all 
functions for each application. This access authority is 
automatically preset to 50 for applications and 
application functions.

In a multi-user environment, the system 
administrator can set the access authority required for 
each application to unique levels. The level is set for both 
“update” (make changes to data) and “details” (only 
view details of data) functions. If the level of 
authorization assigned to a user is equal to or greater 
than the level of authorization required for a given 
application, the user can access that function for that 
application. (Levels of authorization go from a low of 99 
to a high of 1. The lower the number, the higher the 
authority.)

Understanding application functions

Update
A user with sufficient authorization for update 

application access can use all functions in any Smart Alec 
application for which he has authority. This is especially 
common in a single-user environment, where all 
authorization values are the same for all users, so all 
users can access all applications and all application 
functions.

Details
A user with sufficient authorization for details 

application access, but not enough to update 
applications, can only access the details function in any 
Smart Alec applications to which he has authority. This is 
especially common in a multi-user system configuration, 
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where some users only need to view data in the Smart 
Alec system.

Accessing the Application Security Setup application

From the Security Setup group on the SA Bar, click 
once on Application Security Setup. A screen like the one 
shown below will appear, listing existing settings. 

Authorizing application security

The initial value for update and detail authorization 
levels is automatically preset to 50 for all users and for all 
applications.

In a single-user environment, the authorization level 
should remain at 50.

The Smart Alec administrator can change either the 
update or detail values for any application (in Application 
Security Setup) or for a user’s security (in User Account 
Security Setup.) The result will create a multi-user 
environment and can block access to some functions for 
some users.

The graphic below indicates the meaning of the 
Application Security Setup window.
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Click in this 
column to 
select an 
application.

Update button – 
allows you to 
view and change 
values.

Detail Value indicates the 
level of authorization a 
user needs in order to be 
able to view any values in 
that application. Without 
sufficient authority here, 
the user will not even be 
able to access the 
application.

Update Value indicates 
the level of authorization 
a user needs in order to 
be able to change any 
values in that application.

Details button – allows you to view, but 
not to change, values in this application.

Application Application name

AppSecurity.exe Application Security Setup
CommandManager.exe Command Manager
DCGroup.exe Display Command Group Manager
DDEInput.exe DDE Data Source Setup
DeviceInterface.exe Notification Device Interface Setup
DisplayCommandSetup.exe (not used as a user application)
EventLogAck.exe Event Log Acknowledgement
EventLogManager.exe Event Log Manager
NDGroup.exe Notification Device Group Manager
NotificationDeviceSetup.exe Notification Device Setup
Saeditor.exe Message Manager
SAShutdown.exe Smart Alec Shutdown
Security.exe User Account Security Setup
SocketHandlerSetup.exe Socket Handler Setup
VariableRuleManager.exe Variable Rule Manager
VariableSetup.exe Variable Setup
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Authorization for each application can be changed 
individually as follows:

1. Highlight the application to change by clicking 
in the column to the left of that application. Then 
click Update.

2. Assign the values needed for a user to have 
authority to update and to view details. Then 
click either Update or Apply. 

Click in this column to 
select an application.

Update button

NOTE
Remember, the lower numbers 
mean that more authority is 
needed to access the application.

Detail Value indicates the level of 
authorization a user needs in order 
to be able to view any values in that 
application. Without sufficient 
authority here, the user will not even 
be able to access the application.

Update Value indicates the level of 
authorization a user needs in order 
to be able to change any values in 
that application.

Use this drop-down 
arrow to select another 
application to view and 
change.
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3. The following are suggested values for both 
update and details levels for a single-user 
environment and for a multi-user environment 
with an administrator and one or more general 
users.

System application name Common application name
Value for 

single-user 
environment

Value for 
multi-user 

environment

AppSecurity.exe Application Security Setup 50 5
CommandManager.exe Command Manager 50
DCGroup.exe Display Command Group Manager 50 50
DDEInput.exe DDE Data Source Setup 50 5
DeviceInterface.exe Notification Device Interface 

Setup
50 5

DisplayCommandSetup.exe (not used as a user application) 50 50
EventLogAck.exe Event Log Acknowledgement 50 5
EventLogManager.exe Event Log Manager 50 5
NDGroup.exe Notification Device Group Manager 50 50
NotificationDeviceSetup.exe Notification Device Setup 50 5
Saeditor.exe Message Manager 50 50
SAShutdown.exe Smart Alec Shutdown 50 5
Security.exe User Account Security Setup 50 5
SocketHandlerSetup.exe Socket Handler Setup 50 5
VariableRuleManager.exe Variable Rule Manager 50 50
VariableSetup.exe Variable Setup 50 5
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Viewing application authorization levels

1. Highlight the application by clicking in the 
column to the left of that application. Then click 
the Details button.

2. You can now see the values needed for a user to 
have authority to update and view details for 
this application. Then click Close. 

Click here to 
select the 
application.

Details button

NOTE
Remember, the lower numbers 
mean that more authority is 
needed to access the 
application.

Detail Value indicates the level of 
authorization a user needs in order 
to be able to view any values in that 
application. Without sufficient 
authority here, the user will not even 
be able to access the application.

Update Value indicates the level of 
authorization a user needs in order 
to be able to change any values in 
that application.

Use this drop-down 
arrow to select another 
application to view.
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Identifying notification device interfaces

Use Notification Device Interface Setup to designate the 
type of hardware to be used for sending messages to 
notification devices. Notification device interfaces must 
be set up before notification devices can be initialized, 
since the notification devices use the interfaces.

Types of notification device interfaces

There are several types of notification device 
interfaces. Please see “Appendix 3: Notification Device 
Interfaces” on page 96 for descriptions.

Accessing the Notification Device Interface Setup application

From the System Resource Setup group on the SA Bar, 
click once on Notification Device Interface Setup. A screen 
like the one shown below will appear, listing any existing 
notification device interfaces. 
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Adding a notification device interface

1. Choose the correct button for the type of 
notification device interface you wish to add. 
Please see “Appendix 3: Notification Device 
Interfaces” on page 96 for descriptions of the 
various types. 

New Serial 
Interface

New Email 
Interface

New Local 
Pager Interface

New Terminal 
Server Interface

New Wide-area 
Pager Interface
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2. For this example, we will add a wide-area pager 
interface, as shown here. See the table below for 
explanations.

Item Name Description

A Interface name Name of the interface as it will be known.
B Description Description of the interface, for clarity. (Optional)
C Interface settings Choose appropriate settings for this interface. Contact your wide-area 

paging service if needed.
D Dialing properties Choose this button to set up how and where to dial. This function is only 

for the wide-area pager interface.

A
B

C

D
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3. For this example, choose the correct settings for 
the wide-area pager interface. See the table 
below for explanations.

 

Item Name Description

A Modem name Name of the modem used for the pager. At least one modem must already 
be installed.

B Dialing Prefix The prefix to dial to access a public telephone line.
C Country Code Country where the paging service is.
D Area Code Area code where the paging service is.
E Phone Number Phone number to use to access the paging service.
F Number to Dial Complete phone number to dial, created automatically by Smart Alec from 

the components you use in this window.
G Modem Initiation String Initialization string to use for this modem. See the documentation for your 

modem for more information.
H Call Waiting settings Set these if the phone line being used for dialing has call waiting.
I Number of retries Number of times to attempt connection.
J Local call Indicates that this is a local call.

A

B

C

D

E

F

G

H

I

J
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Settings for additional notification device interfaces

In addition to the wide-area pager illustrated above, 
here are settings for serial, email, local pager, and 
terminal server interfaces. Note that there is no modem 
interface.

Serial interface

Email interface

Local pager interface

Terminal server interface

Item Name Description

A Interface name Name of the interface as it will be known.
B Description Description of the interface, for clarity. (Optional)
C Interface settings For an ALPHA sign, use 9600 baud, 8 bits, no parity, and one stop bit.

Item Name Description

A Interface name Name of the interface as it will be known
B Description Description of the interface, for clarity (Optional)
C Email profile Email identity to use. See your system administrator if unsure.
D Email password Password that is valid for the email profile

Item Name Description

A Interface name Name of the interface as it will be known.
B Description Description of the interface, for clarity. (Optional)
C Interface settings Choose appropriate settings for this interface. To find these (except Packet 

Size) click Start > Settings > Control Panel > System. Next, click the Device 
Manager tab and then Ports. Finally, click the COM port you need and then 
the Port Settings tab.

D Packet size The maximum number of bytes the pager can process at a time. refer to 
the documentation for the pager for details.

Item Name Description

A Interface name Name of the interface as it will be known.



Identifying notification device interfaces

45

B Description Description of the interface, for clarity. (Optional)
C IP address The four-node Internet Protocol address of the terminal server

Item Name Description
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Identifying notification devices

Use Notification Device Setup to designate the names 
and properties to be used for places where messages will 
be displayed (i.e., signs, pagers, and email).

Notification devices have properties. Examples of 
some properties that may be required are:

• Device name
• Description
• Device type
• Device address
• Authorization level
• Name of the notification device interface to use
• Cap code

Accessing the Notification Device Setup application

From the System Resource Setup group on the SA Bar, 
click once on Notification Device Setup. A screen like the 
one shown below will appear, listing any existing 
notification devices. 
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Adding a notification device: ALPHA, pager, email

1. Choose the correct button for the type of 
notification device you wish to add. 

2. For this example, we will add an ALPHA SA 
device, as shown here. See the table below for 
explanations.  

Item Name Description

A Device name Name of the device as it will be known.
B Device description Description of the device, for clarity. (Optional)
C Device type Model of ALPHA SA sign
D Interface category Type of notification device interface (serial, pager local, or terminal server)

Add ALPHA SA 
device

Add pager 
device

Add email 
device

A

B

C

D

E

F

G

I
H
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3. For a new ALPHA SA notification device, the 
Advanced button is for these properties.

E Interface name Specific notification device interface. The only options available are those 
belonging to the selected Interface category.

F Notification device 
authorization level

Authorization level a user would need to access this notification device.

G Device address Serial address assigned to the ALPHA SA sign. (This is displayed when the 
sign is powered up.)

H Cap code
– or –

Interface port address

For Pager Local interface category, 
– or –

For Terminal Server interface category, 
I Advanced Choose this button for more advanced functions. See the next step.

Item Name Description

A Message confirmation When Message Confirmation is enabled, the sign sends a response to the 
sender to confirm that the message has been received.

B Machine address Address of the computer where the ALPHA SA sign is installed or 
associated. (The sign might be wired directly, or associated by modem, 
LAN, or wireless transmission, etc.) The Machine Address is currently not 
used.

Item Name Description

A

B
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Settings for additional notification devices

In addition to the ALPHA SA device illustrated 
above, here are settings for pager and email devices. 

Pager device

Email device

Item Name Description

A Device name Name of the device as it will be known.
B Device description Description of the device, for clarity. (Optional)
C Device type Choose numeric or alphanumeric
D Interface category Type of notification device interface (pager local or pager wide area)
E Interface name Specific notification device interface. The only options available are those 

belonging to the selected Interface category.
F Notification device 

authorization level
Authorization level a user would need to access this notification device.

G Pin # Pager identification number
I Advanced Choose this button for more advanced functions, as for the ALPHA SA 

device above.

Item Name Description

A Device name Name of the device as it will be known.
B Device description Description of the device, for clarity. (Optional)
C Device type Choose email.
D Interface category Type of notification device interface (pager local or pager wide area)
E Interface name Specific notification device interface. The only options available are those 

belonging to the selected Interface category.
F Notification device 

authorization level
Authorization level a user would need to access this notification device.

G Email address Destination address for the e-mail message
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Identifying variables

Use Variable Setup to designate real-time (“as it 
happens”) variables to be available in Smart Alec. 
Variables represent values that can change at any time. 
The values for the variable can come from a number of 
places outside of Smart Alec, such as a production line, a 
spreadsheet, manual data entry, and others. (See 
page 103 for a more complete definition of variable.)

Accessing the Variable Setup application

From the System Resource Setup group on the SA Bar, 
click once on Variable Setup. A screen like the one shown 
below will appear, listing any existing variables. 
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Adding a variable

1. Choose the button to add a new variable. 

2. For this example, we will add a variable called 
“Defects 1”, as shown here. See the table below 
for explanations.  

Item Name Description

A Variable Name Name of the variable as it will be known
B Description Description of the variable, for clarity (optional)
C Category User-defined category for the variable (optional)
D Variable Authorization 

Level
Security level needed to use the variable

E Data Type Format of data for the variable:
• Integer: a whole number (with no fraction)
• Float: any number other than an integer. Can include decimals.
• String: text, including alphabetic, numeric, and other characters

Add a variable

A
B
C

D

E
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Establishing DDE input data sources

Use DDE Data Source Setup to designate what data 
will be coming from outside of Smart Alec using DDE 
(Dynamic Data Exchange), where it will come from, and 
how you want to use it. The link to this data can be used 
to provide values for variables.

Smart Alec can act as a DDE client. It needs a DDE 
server to communicate with in order to provide values 
for variables. Many existing programs already function 
as DDE servers, such as Wonderware’s Intouch and 
Microsoft Excel. To use these or any other DDE-server 
applications with Smart Alec, you must use the service, 
topic, and item names which are to supply values for the 
variables from the DDE server. The DDE server 
application’s documentation should provide these. (The 
discussion in the following sections uses Microsoft Excel 
as an example.)

Smart Alec establishes a request-and-advise loop 
when it requests an item from a DDE server. This means 
that Smart Alec requests the item’s value once from the 
DDE server and then the DDE server is responsible for 
sending the item to Smart Alec each time the item 
changes value.

NOTE: When using DDE, Smart Alec must be 
installed on the same computer as the external 
data source, and that source must be 
Windows-based. When using NetDDE, Smart 
Alec must be installed on the same network as 
the external data source, and that source must 
be Windows-based.

Also, the external data source must be running 
before starting the Smart Alec system. 
Otherwise, the Smart Alec DDE processor 
(DDEInputHandler.exe) will not run.



Establishing DDE input data sources

53

Accessing the DDE Data Source Setup application

From the System Resource Setup group on the SA Bar, 
click once on DDE Data Source Setup. A screen like the 
one shown below will appear, listing any existing DDE 
data sources.

Adding a link to a DDE data source

1. Choose the button to add a new DDE data 
source. 

Add a DDE 
data source.
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2. For this example, we will add a link to a 
Microsoft Excel spreadsheet as DDE data source. 
See the table below for explanations.

 

Item Name Description

A Service Name of the application the data comes from.
B Topic Refer to the documentation for your DDE server application to determine 

the correct topic for that application.
In this example, the topic identifies the specific Excel workbook you want 
(set off by brackets) and the specific worksheet within that workbook.
For Excel, you must identify both the workbook and the individual 
worksheet if there is more than one worksheet. If there is only one 
worksheet in that workbook, then you can simply type the name of the 
workbook rather than specify workbook and worksheet.

C Item The specific piece of data to be used. In this case, the cell (row and 
column) is used.

D Server path The full path to the file for the DDE data source.
If the file is on a computer other than the one where Smart Alec is running, 
you must include both the server and full path to the file. See your network 
administrator to determine the best way to specify the Server path to that 
computer.
NOTE: The DDE server application must be running before the DDE link 
can be active.

E Default Value The value to be used for the variable when none is supplied by the DDE 
data link, such as if the DDE server stops running for any reason.

A

B

C

D

E

F

G

H

I
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Accessing DDE input data

For accessing DDE input data, 
DDEInputHandler.exe must be running. (See “All 
background processor applications” on page 10.) Before 
this application starts, you must be running any 
application which is to provide data using DDE. This is 
because if DDEInputHandler.exe does not find any DDE 
data source, it shuts itself down without retrying. When 
running and accessing a valid DDE source, 
DDEInputHandler.exe feeds data to the Smart Alec 
system and variables are updated.

F Data Class The type of data sent into the Smart Alec system from the DDE server.
• Raw data: All data received from the DDE server will be sent to Smart 
Alec without any preprocessing or formatting. This assumes that all the 
data sent to Smart Alec is valid for presenting on a notification device.
• ASCII printable: ASCII control codes (non-printable characters) will be 
deleted before sending the data on to Smart Alec, leaving only data that is 
valid for presenting on a notification device.
NOTE: Regardless of the Data Class, all DDE data is restricted to 128 
characters. If the value is longer, it will be truncated (cut off) to 128.

G Smart Alec Variable to 
Update

The variable in Smart Alec for which this data will supply the value. The 
variable must first be established. See “Identifying variables” on page 50.

H Filter On checkbox Indicates that you want to filter the DDE data with a Delta Value. If you do 
not check this on, Smart Alec will update the value of the variable 
whenever the value changes, however small that change is. (NOTE: Some 
DDE server applications update all values whenever any of the values 
change. Microsoft Excel is one application that does this.) This may cause 
more processing than you want, depending on the frequency of the 
changes.

I Delta Value The number that is used to set a “plus or minus” range for the value of the 
variable. (So if the value of the variable is 5 and the Delta Value is 2, then 
the range would be from 3 to 7.) The value of the variable is compared 
with this range. If the value of the variable is outside the range (higher or 
lower), then that value of the variable is used to update the variable 
wherever the variable is used for a command. Otherwise, the value of the 
variable is not updated.

Item Name Description
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Establishing socket input data sources

Sockets are a way (besides DDE) to import data into 
Smart Alec from external data sources, using a client/
server relationship. 

NOTE: A user must have a password in order to set up 
sockets. See “Creating user environments” on 
page 28.

General steps for communications using sockets

In general, the steps for using sockets with Smart 
Alec are as follows:

1. Start and log into Smart Alec. See “Logging into 
Smart Alec” on page 7.

2. Establish the specific computer port number to 
use between Smart Alec and the external system. 
See “Accessing the Socket Handler Setup 
application” below.

3. Initiate a socket connection between the systems.
4. Send data from the external data source to Smart 

Alec. Please see“Appendix 6: SA 2.1 Socket 
Interface – API Process Guide” on page 104 for 
detailed instructions on using sockets to send 
data into the Smart Alec system.

Accessing the Socket Handler Setup application

From the System Resource Setup group on the SA Bar, 
click once on Socket Handler Setup. A screen like the one 
shown below will appear.
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Setting the port number

1. Type the port number to use for the socket 
connection. Valid port numbers are 1025 and 
above. The default port number is 8150. 

2. Click OK.
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Managing the Smart Alec system
When using the Smart Alec system, you can:
• Create messages.
• Create and schedule commands for messages.
• Group notification devices and display 

commands.
• Create rules for variables.
• Monitor and manage events that occur in Smart 

Alec.

Creating messages

A message is a unique, unified set (file) of 
information – a “thought”. It can be saved and/or sent to 
a notification device. Its “look and feel” is based on that 
specific device.

A message is defined using the Message Manager. It 
may include some or all of the following properties, 
either specified or defaulted:

• Text
• Graphics
• Formatting
• Time/date/temperature
• Variables
• Animation
A message does not include the following, which are 

designated using Command Manager for the message:
• Scheduling
• Location/destination
• Priority
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Accessing the Message Manager application

From the System Resource Setup group on the SA Bar, 
click once on Message Manager. A gray screen, like the one 
shown below, will appear the first time you start Message 
Manager. After you create one or more messages, when 
you start up Message Manager, it will show a blank white 
screen with the message called “New message”.

NOTE: When you first create messages and the 
commands for them, you may want to practice 
with a few messages to achieve different 
effects on the notification device. If you don’t 
achieve the desired effect with a message, it 
may be easier to delete the message and create 
a new message.
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Components of the Message Manager window

The picture below is representative of the Message 
Manager window. See the table below for explanations of 
the components.

 

Item Name Description

A Message name Name you want to give to the message.
B Message selection Drop-down box to select from the full list of created messages.
C Mode button Allows you to set modes, which are special effects that change the way a 

message appears on a sign, and the position of a message on the sign.
D Mode pause (speed) 

button
Allows you to set the length of time to pause before repetition of this 
message.

E Justification button Allows you to set character spacing and left-, center-, or right-justification.
F Fonts button Allows you to select the font and the number of LED rows to use for 

characters that follow.
G Color button Allows you to set the color to use for whatever follows.
H Width button Allows you to set characters that follow to display as wide or double-wide.
I Height button Allows you to set characters that follow to display as double-high.
J Flash button Allows you to turn flashing on or off for whatever follows this control, until 

changed by another Flash control.
K True descenders button Allows you to indicate that characters that follow are to be displayed using 

true descenders, so that, for instance, the tail of a “g” drops below the 
main base line of text.

A C D E F G H I J K L M N O

Q R S T

P

B
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Creating a new message

1. Choose File > New.

2. Enter the message name. Click OK. 

NOTE: There is no default button selected anywhere 
in Message Manager, so you need to actually 
select the OK button, not just press Return on 
the keyboard. You can either use the mouse to 
select the OK button or tab to it. 

3. Use the Message Manager buttons and their 
pop-up screens to define the formatting and 
components of the message. An example is 
shown below.

L New line/New page 
button

Allows you to indicate that whatever follows is to go on the next line or the 
next page of the sign.

M Object button Allows you to insert time, date, animation, and temperature, (Counter is 
also an option, but it is not used in the Smart Alec system.)

N Variable button Allows you to insert a placeholder for an existing variable.
O Close box Closes the Message Manager.
P Message area Area for message text, variables, etc., as well as controls for the message 

and its contents.
Q Status bar Indicates current status and error messages.
R Cursor position 

indicator
Shows the position of the cursor in the message.

S Date indicator Shows the current date.
T Time indicator Shows the current time.

Item Name Description
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4. Choose File > Update.

NOTE: You should choose File > Update to save your 
message. There is no prompt to save when you 
close the Message Manager with the close box. 
(However, there is a prompt to save when you 
close the Message Manager with File > Exit and 
also when you select a different message.)

5. You will be prompted to verify that you want to 
update this message. Select the OK button.

Selecting a different message

1. Click on the message selection drop-down box.

Mode Mode 
pause

Justification Font Color Text Variable
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2. This gives a list of all the messages available. 
Click on the message you want to edit.

3. The message you choose is shown in the 
message name box and the message area.

Changing a message

1. Select the message to be changed.
2. Make the changes you need.
3. Choose File > Update.
4. You will be prompted to verify that you want to 

update this message. Select the OK button.

NOTE: A changed message will only be displayed as 
changed after a) it is deleted from and resent to 
the notification device with Command 
Manager, or b) the Smart Alec system is 
restarted.

Deleting a message

1. Select the message to be deleted.
2. Choose File > Delete.
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3. You will be prompted to verify the delete.

4. The message will be deleted and the next 
message in the list will be displayed.

Displaying a message on a notification device

To actually display a message on a notification 
device, there must be a command for it. See “Using 
commands to control messages” on page 67.

If you have changed a message, the change will only 
take effect after

1. a command is issued for a different message and 
then a command is issued to replace the old 
changed message with the new changed 
message, or

2. the Smart Alec system is restarted.

NOTE: Restarting the system does not reissue 
commands which were in progress 
before the restart.

Checking the message syntax

“Syntax” refers to the construction of words, phrases, 
sentences, or messages according to established rules. 
The construction must be correct for a message to be 
displayed correctly. The Message Manager can check the 
syntax of messages for you. Follow the steps below to 
determine and fix any errors.
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1. As an example, say you accidentally deleted the 
name of a variable to be used in a message.

2. Choose Tools > Message Syntax Check.

3. If there are errors, as there are here, a window 
will show the cursor position of the start of the 
error and when the process is complete.

4. Place the cursor in the message where indicated 
by the column number and message statistics.
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5. Determine the error and correct it.

6. When there are no errors in the message, the 
syntax check so indicates.
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Using commands to control messages

A command is used to control messages:
• Add a single message
• Delete a single message
• Erase all messages from the display, or
• Replace all messages with a single message
Commands can be scheduled for a specific date and 

time or for a recurring time period.

Accessing the Command Manager application

From the System Resource Setup group on the SA Bar, 
click once on Command Manager. A screen like the one 
shown below will appear listing any existing commands.
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Command Manager,
left end

Command Manager,
right end
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Adding a command

1. Choose the button to add a new command. 

2. This example creates a command to add the 
message for the Line 1 production count on the 
Line 1 sign. The table below and the next steps 
explain each item and how to create it.

Add a 
command.

A

B

C

D

E

F

G

H

I

J

K

L
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3. Specify the Command Name and Description.
4. Choose an Action from the available options in 

the drop-down list.
5. Choose a Message, if applicable, from the 

available options in the drop-down list.
6. Set the Execution Priority and Run Priority.
7. Click the Destination button to bring up the list, 

as in the next step.

Item Name Description

A Command Name Name of the command.
B Description A more complete explanation of the command.
C Action What you want to be done with the message(s):

• Add a single message
• Delete a single message
• Erase all messages from the display, or
• Replace all messages with a single message

D Message Name Select a message for the action. Valid for all Actions except “Erase all 
messages”.

E Execution Priority The level of authority needed by a user to execute this command.
F Run Priority The priority of this command on the display, to be compared with other 

commands being executed on that display.
G Destination button Click this to bring up a list of available destinations to select from.
H Destination The list of one or more destinations selected for executing this command.
I Owner Specify who can access and use this command.

• Public: This command can be used by anyone. Use this in a single-user 
system.
• Private: This command can only be used by the person who created it. 
Use this only in a multi-user system.

J Schedule Command 
checkbox

Check this on if you want to specify a time frame for this command. 
(Optional)

K Schedule Information Allows you to set the start date and time and end date and time.
L Recurrence button When the command is scheduled, you can click this button to bring up the 

options for repeating this command. The options are:
• Daily (every x number of days or every weekday)
• Weekly (every x number of weeks on specific days)
• With an end date (none, after x number of occurrences, or by a specified 
date.)
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8. Select one or more Destinations by clicking (or 
Control-Click or Shift-Click) on a Destination and 
then on the double-arrow button. Then click OK.

9. Specify the Owner.
10. If you wish to specify a date and time for the 

command to be executed, click on the Schedule 
Command checkbox.

11. Next, set the schedule’s Start and End Date. Do 
this by clicking on the down-arrow by the date. 
A monthly calendar will pop up. Select a date 
from the current month, or move to a different 
month with the left- or right-arrow. Click on the 
desired date on the calendar. It will be used for 
the schedule date. In this example, August 2 is 
chosen for the start date.

To remove a destination 
from the list on the 
right, click on it and 
press the Delete key.

Single destinations 

Group destinations 

NOTE
If you set a schedule for this 
command, the Recurrence 
column in the main window (see 
“Accessing the Command 
Manager application” on 
page 67) will indicate either 
“yes” or “no”. If there is no 
schedule, it will be blank.
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12. Complete the scheduling by setting the Start and 
End Time. Do this by clicking on each element of 
each time (that is, the hour, minute, or second) 
and then using the up- or down-arrows to 
increase or decrease the setting.

NOTE: You must set the start time and the end time to 
a time which is at least one minute later than 
the current time on your computer. These 
times cannot be the same as the current time.

NOTE: If you do not specify a schedule for this 
command, it will be executed based on the 
display command rule set up for this 
command in Variable Rule Manager.

13. You can set recurrence timing by clicking on the 
Recurrence… button. This gives these options:
• None
• Daily (every x number of days or every 

weekday)
• Weekly (every x number of weeks on specific 

days)
• With an end date (none, after x number of 

occurrences, or by a specified date.)
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After you set the recurrence options, click OK.

NOTE: If you do not set recurrence timing, the 
command will be executed either for the 
scheduled date and time only, or based on the 
display command rule set up in Variable Rule 
Manager for this command, depending on 
how you have set it.

14. Click either Add or Apply for the Add Display 
Command window.
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Grouping notification devices

Use Notification Device Group Manager to designate 
logical groups of devices to facilitate sending a message 
to multiple notification devices simultaneously. 

NOTE: Notification devices are created using 
Notification Device Setup. See “Identifying 
notification devices” on page 46.

Accessing Notification Device Group Manager

From the System Resource Management group on the 
SA Bar, click once on Notification Device Group Manager. 
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Adding a Notification Device Group

1. Choose the button to add a new notification 
device group. 

2. For this example, we will add a notification 
device group called “Front offices”, as shown 
here. See the table below for descriptions.

Add a notification 
device group

A

B

C

D
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Item Name Description

A Group name Name of the notification device group as it will be known
B Group Description Description of the notification device group, for clarity (Optional)
C Ownership  Specify who can access and use this notification device group:

• Public: This group will be available to everyone. Use this in a single-user 
system.
• Private: This group will be available only to the person who created it. 
Use this only in a multi-user system.

D Notification Device Choice of notification devices to be included in the group. Click on any you 
wish to include.
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Grouping display commands

Use Display Command Group Manager to designate 
logical groups of display commands. Then you can create 
another command to submit the command group. Doing 
this lets you essentially issue a series of commands all at 
once.

NOTE: Display commands are created using Command 
Manager. See “Using commands to control 
messages” on page 67.

Accessing Display Command Group Manager

From the System Resource Manager group on the SA 
Bar, click once on Display Command Group Manager. 
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Adding a Display Command Group

1. Choose the button to add a new display 
command group. 

2. For this example, we will add a display 
command group called “Line counts”, as shown 
here. Click on either Add or Apply. See the table 
below for explanations.

Add a display 
command group

A

B

C

D
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Item Name Description

A Group name Name of the display command group as it will be known
B Group Description Description of the display command group, for clarity (Optional)
C Ownership Specify who can access and use this display command group:

• Public: This group will be available to everyone. Use this in a single-user 
system.
• Private: This group will be available only to the person who created it. 
Use this only in a multi-user system.

D Display Command Choice of display commands available to be included in the group. Click on 
any you wish to include.
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Using variable rules

Use Variable Rule Manager to designate rules (pre-
defined conditions with resulting actions). Please see 
“How Smart Alec uses variables” on page 18 for more 
information.

Accessing the Variable Rule Manager

From the System Resource Management group on the 
SA Bar, click once on Variable Rule Manager. A screen like 
the one shown below will appear, listing any existing 
variable rules.

Adding a variable rule

There are three types of variable rules. They are 
explained in “Types of variable rules” on page 18. All 
three will be shown here.
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Adding a counter rule
1. Choose the button to add a new counter rule. 

2. Enter the information to define usage of this 
counter rule. Click either Add or Apply. See the 
table below for explanations. 

Item Name Description

A Rule name Name of the counter rule as it will be known
B Rule Description Description of the counter rule, for clarity (Optional)
C Variable Name Name of the variable which will be displayed
D Text Length Maximum number of characters to allow for the length of the variable to 

display
E Text Justification Whether text will be right- or left-justified

Add a counter rule

A

B

C
D

E

F

G
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Adding a counter with alarm rule
1. Choose the button to add a new counter with 

alarm rule. 

F Text Attributes Color to use when displaying the variable and whether or not the variable 
will flash. Colors available depend on the notification device.

G Owner Specify who can access and use this rule.
• Public: This rule can be used by anyone. Use this in a single-user system.
• Private: This rule can only be used by the person who created it. Use this 
only in a multi-user system.

Item Name Description

Add a counter with 
alarm rule
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2. Enter the information to define usage of this 
counter with alarm rule. Click either Add or 
Apply. See the table below for explanations. 

Item Name Description

A Rule name Name of the counter with alarm rule as it will be known
B Rule Description Description of the rule, for clarity (Optional)
C Variable Name Name of the variable to be displayed
D Text Length Maximum number of characters to allow for the length of the variable to 

display
E Text Justification Whether text will be right- or left-justified
F Text Attributes For each range:

• Limit/threshold between this (high or low) range and the normal range
• Color to use for displaying the variable
• Whether or not the variable will flash

G Owner Specify who can access and use this rule.
• Public: This rule can be used by anyone. Use this in a single-user system.
• Private: This rule can only be used by the person who created it. Use this 
only in a multi-user system.

H Decimal Value If the value for the variable used in this variable rule has a decimal, the 
Decimal Value indicates how many decimal places to use in the value for 
the variable. (For example, if the value for the variable has 5 digits with a 
Decimal Value of 2, then the number “12345” would be considered as 
“123.45”.) NOTE: The Decimal Value property is only available if the Data 
Type of the variable is “float”. Otherwise, you will not see this property.

A

B

C
D

E

F

G

H
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Adding a display command rule
1. Choose the button to add a new display 

command rule. 

2. Enter the information to define usage of this 
display command rule. The final result of this 
window creates a statement expressing a 
conditional command, that is, a command that 
will only be executed if all the preceding 
conditions are met. See the table below for 
explanations.

NOTE: Use care when setting this statement. If this 
statement is not correctly set, either nothing 
will happen or the wrong action will be taken.

Add a display 
command rule

A

B

C

D

K

E F G H I J

Each row of this table 
creates a phrase in the 
conditional command 
statement.
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Item Name Description

A Rule name Type the name by which the rule is to be called.
B Trigger Variable Select the variable to be used to start this rule’s test.
C Description Type the description of the rule, for clarity. (Optional)
D Format Shows the complete format of the rule you create. Automatically entered 

by Smart Alec as you complete the sections of the rule.
E Boolean operators Choose as appropriate from the following list:

• If
• And
• Or
• Then
The choice depends on what you want the rest of the row to do in relation 
to the other phrases.
The first row always starts with “IF” and Items F through J must be 
completed. The last row you use must always start with “THEN’ and end 
(Item I) with the command you want to be done when the entire statement 
is executed.
You can have rows in between the first and last rows and these can start 
with either “AND” or “OR” to create additional conditions that must be met 
before the command will be done.

F Operand 1 Choose the variable to test from a list of existing variables.
G Operator Choose from the following list for comparing Operand 1 with Operand 2:

• Is equal to ( = )
• Is not equal to ( != )
• Is greater than ( > )
• Is greater than or equal to ( >= )
• Is less than ( < )
• Is less than or equal to ( <= )

H Operand 2 Specify the value to compare Operand 1 to. Can be a variable or a literal 
value. (See Item J.)

I Resulting display action Choose the display command to be executed when all conditions are met.
The choice is from a list of existing display commands or groups of 
display commands.

J Variable/literal value 
switch

Click as needed to set this as checked or unchecked.
• Checked: the choices for Item H consist of variables in a drop-down list.
• Unchecked: you can type in your own specific value for Item H.

K Owner Specify who can access and use this rule.
• Public: This rule can be used by anyone. Use this in a single-user system.
• Private: This rule can only be used by the person who created it. Use this 
only in a multi-user system.
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Managing the log of Smart Alec system events

For system support purposes, Smart Alec monitors 
and creates a log of all events that occur within the 
system. This log is available to view by using the Event 
Log Manager. Some of the events may be serious enough 
that someone should review them and decide if 
something should be done about them. Smart Alec 
identifies these events and allows a user to acknowledge 
having seen them by using the Event Log 
Acknowledgement application. All events listed in the 
Event Log Acknowledgement application must be 
acknowledged before they can be deleted from the log.

Accessing the Event Log Manager

From the Event Log group on the SA Bar, click once 
on Event Log Manager. A screen like the one shown below 
will appear. See the table below for descriptions.
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Item Name Description

A Write to file Create a tab-delimited print (.prn) file with user-selected fields from the 
database.

B Delete Delete selected event(s).
C Archive Save the entire database as a text (.txt) file.
D Filter Select only events that fit specific criteria (data/time and/or database field).
E Compact database Makes the event log database smaller by removing obsolete references.
F Sort Ascending Sort A to Z or 0 to 9.
G Sort Descending Sort Z to A or 9 to 0.
H Search After selecting a column, use this to search for a specific value.

A C

D

E

F

G

HB
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Options for viewing the event log database in the Event Log Manager

• Write to a file: Create a tab-delimited print (.prn) 
file with user-selected fields from the database.

• Filter: Select only events that fit specific criteria 
(date/time and/or one or more database fields)

• Refresh: Update the list of events



Managing the log of Smart Alec system events

89

• Invert selection: Select only those records not 
already selected.

• Sort: Sort high-to-low or low-to high.

Options for managing the event log database

• Select all: Highlight all records. This allows you 
to then delete all records at one time.

• Control database size: Set preferences to limit the 
number of events listed in the database to a 
specific number, to overwrite the oldest records 
(never, as needed, or after x number of days), 
and to state the wording of the warning message 
when the number of events in the database has 
reached the limit.

• Archive: Save the entire database as a text (.txt) 
file.

• Compact: Make the event log database smaller 
by removing obsolete references.

Accessing the Event Log Acknowledgement application

When you acknowledge a record in the Event Log 
database, it is marked as acknowledged and is removed 
from the list of events needing acknowledging. You can 
use this list as a checkoff list for things to review and/or 
check into.

From the Event Log group on the SA Bar, click once 
on Event Log Acknowledgement. A screen like the one 
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shown below will appear. See the table below for 
descriptions.

 

Item Name Description

A Sort Ascending Sort A to Z or 0 to 9.
B Sort Descending Sort Z to A or 9 to 0.
C Filter Select only events that fit specific criteria (data/time and/or database field).
D Search After selecting a column, use this to search for a specific value.

A C

DB
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Options for viewing the event log in Event Log Acknowledgement

• Filter: Select only events that fit specific criteria 
(date/time and/or database field)

• Refresh: Update the list of events

• Sort: Sort high-to-low or low-to high.

Options for acknowledging events

• Preferences: Sets the refresh rate. Also sets 
whether to always run the Event Log Manager in 
the background when Smart Alec starts up 
without waiting for a user to start it from the SA 
Bar.

• Acknowledge: Displays a window for the selected 
record showing all of the values for the event. 
Allows you to view the previous/next record. 
When you acknowledge a selected record, it is 
marked as acknowledged in the Event Log 
database and is removed from the list of events 
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needing acknowledging. You can use this list as a 
checkoff list for things to review and/or check 
into. 

• Acknowledge All: Same as Acknowledge but applies 
to all records in the list without viewing any 
records.
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Appendices

Appendix 1: Troubleshooting

Starting the background processing applications

If the Smart Alec applications that do the processing 
do not start with Start > Programs > Smart Alec for any 
reason, you can manually start them. In Explorer, 
double-click on alecstart.exe in the Smart Alec directory. 
This will start:

• SABar.exe (the primary user interface)
• SAevtmgr.exe (the background event manager)
• Sockhandler.exe (the background socket data 

manager)
• DDEInputHandler.exe (the background DDE 

data manager) If this does not run, it may be that 
the external data source is not running before 
starting Smart Alec. Start the external data 
source and then start Smart Alec.

(In Windows, you can see which programs are 
running by pressing Ctrl/Alt/Del together. Be sure to 
choose Cancel here rather than End Task or Shut Down.)

Where to go for additional help

If you need assistance, please follow this procedure:
1. Refer to relevant topics in this manual.
2. Refer to online Help for the specific application.
3. Contact your authorized Smart Alec reseller.
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What you need to provide when you need assistance

If you need technical assistance, you will need to 
provide:

• full description of the problem
• the sequence of steps that lead up to the problem
• computer system hardware and relevant 

software application version numbers
• the version number of Smart Alec found in the 

splash screen when Smart Alec starts.
• the product serial number – found on the outside 

packaging and on the registration card
• the version number of any relevant Smart Alec 

applications, found by right-clicking on the 
application in Explorer, choosing Properties then 
clicking on the Version tab.



Appendix 2: Smart Alec computer requirements

95

Appendix 2: Smart Alec computer requirements

Make sure your hardware system fits these 
minimum requirements:

• Personal computer, IBM or compatible
• Mouse and CD-ROM drive
• SVGA 800 x 600 color monitor
• Microsoft Windows 95,

Microsoft Windows 98, or
Windows NT Workstation 4.0

• 64 MB RAM
• Pentium 120 MHz processor, minimum
• 25 MB hard disk storage space
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Appendix 3: Notification Device Interfaces

The Smart Alec system includes the following 
notification device interfaces.

NOTE: You may have purchased notification devices 
from other third party sources. These are not 
supported by Adaptive Micro Systems. You 
will need to consult the third party source for 
any needed assistance.

Serial interface

A serial notification device interface uses cables to 
connect ALPHA SA signs into a network, and messages 
are sent over this cabling.

A serial interface works best when all the notification 
devices are in one building.

Email interface

An email notification device interface sends 
messages over a network using an email service.

ALPHA sign

ALPHA signALPHA sign

PC – sign – sign – sign – etc.

PC with Smart Alec software

LAN

PC with email recipient

PC as email distributor

LAN

PC – LAN network – PC used as email distributor – PC email
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Local pager interface

A local pager notification device interface uses a 
transmitter attached to a computer and a wireless 
receiver attached to a notification device. Messages are 
sent from the computer via a transmitter to wireless 
receivers and pagers attached to the notification devices.

The advantage of this connection method is that 
wiring does not have to be strung between notification 
devices.

Wide area pager interface

A wide area pager notification device interface uses a 
modem attached to your computer and a wireless 
receiver attached to a remote notification device, either a 
display or a pager. Basically, when a message is sent, it is 
transmitted to the remote notification device when the 
computer modem calls the device’s modem. Specifically, 
a message is sent from your computer to the attached 
modem. The modem then dials a paging service, such as 
SkyTel, and this paging service actually transmits the 
message to the wireless receiver.

A modem connection is often used for devices that 
are not in the same building and possibly not in the same 
city. It works best when message data does not change 
rapidly.

PC with Smart Alec software

Data Receiver

ALPHA sign

Data Receiver

ALPHA sign

Pager

PagerPager

Transmitter

PC – pager base station – pager or pager-to-sign
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Terminal server interface

A terminal server notification device interface uses a 
Local Area Network cabling system to transmit messages 
to a device on the LAN with an IP address.

PC with Smart Alec software

Modem

Data Receiver

ALPHA sign

Data Receiver

ALPHA sign

Radio Paging Network

Pager

PagerPager

PC – modem – pager base station – pager or pager-to-sign

PC with Smart Alec software

LAN

ALPHA sign

Terminal  Server

ALPHA sign

ALPHA sign

PC – LAN network – terminal server box – sign – sign – sign – etc.
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Appendix 4: What modes are available on signs

Modes are special effects used to change the way a 
message appears on a sign.

Table 1: Modes available on signs.

Sign
(FM = Full Matrix,

CM = Character Matrix, 
LM = Line Matrix)

Modes

A
ut

om
od

e

B
ul

le
ti

n

Fl
as

h

H
ol

d

In
te

rl
oc

k

R
ol

l

R
ot

at
e

S
cr

ol
l

S
lid

e

S
no

w

S
pa

rk
le

S
pr

ay

S
ta

rb
ur

st

S
w

it
ch

Tw
in

kl
e

W
ip

e

ALPHA
sign Ty

pe

S
ta

nd
ar

d

C
on

de
ns

ed

Series 200 FM � � � � � � � � � � � � � � � �

Series 300 FM � � � � � � � � � � � � � � � �

Series 4000 FM � � � � � � � � � � � � � � �

Series 7000 FM � � � � � � � � � � � � � � � �

Big Dot FM � � � � � � � � � � � � � � � �

Alphavision FM FM � � � � � � � � � � �

Alphavision CM CM � � � �

790i FM � � � � � � � � � � � � � � �

Solar FM � � � � � � � � � �

Director CM � � � �

2.1-inch CM CM � � � �

3.2-inch CM CM � � � �

PPD LM � � � � � � � � � � � � � � �
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Administrator
Normally the applications that are needed to set up 

the Smart Alec system are available only to an 
administrator, while the applications needed for routine 
management of messaging needs are available to all 
users. In an environment where only one person is 
responsible for using Smart Alec, this user is also the 
administrator, with full access to all applications.

Security is available so that, for instance, applications 
needed only by the Smart Alec administrator (to set up 
the system) are not accessible by normal users (for 
general management of the system.)

Command
A way for a user to communicate a request for a 

desired physical action at a notification device. A 
command consists of message content, notification 
device destination, and running priority. It is formatted 
according to what is needed for each particular 
notification device.

A command can, but does not always, trigger action, 
depending on priorities and prerequisite conditions. 
Pre-set variable display command rules can control when 
commands are processed, or commands can be 
scheduled.

Details
If you have enough “details” authorization to use an 

application, that application will appear in the SA Bar for 
you. You will be able to use that application and view 
details of any data in it, but you will not be able to make 
any changes to it.

Dynamic Data Exchange
Dynamic Data Exchange, or DDE for short, is a 

programming method by which Windows-based 
computer applications can exchange data when running 
simultaneously, generally on the same computer. This 
way they can “communicate” directly and actions in one 
system can be triggered by data in another system.
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External data source
A source of data or information outside of the Smart 

Alec system. Also known as a data server. One example 
of an external data source could be a production line 
system, such as Intellution or WonderWare, providing 
machine statistics, like the number of parts produced per 
minute or a machine's temperature. Another example of 
an external data source could be a Microsoft Excel or 
Lotus 1-2-3 spreadsheet.

Message
A message is a unique, unified set (file) of 

information – a “thought”. It can be saved and/or sent to 
a notification device. Its “look and feel” is based on that 
specific device.

A message is defined using the Message Manager. It 
may include some or all of the following properties, 
either specified or defaulted:

• Text
• Graphics
• Formatting (font, font size, color, etc.)
• Time/date/temperature
• Variables
• Animation
A message does not include the following, which are 

designated using Command Manager for the message:
• Scheduling
• Location/destination
• Priority

Multi-user environment
A “multi-user” environment is appropriate when 

users should not necessarily have access to the same 
applications and application functions; that is, access can 
be restricted for some users for applications, application 
functions, or system inputs or resources. For example, 
you may want to restrict a clerk’s authority and not allow 
that person to send messages to the signs on the 
production floor. But you would want the building 
security manager to be able to send a fire alarm to every 
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sign. Also, you might not want either of these people to 
be able to set authority for other users.

Notification Device
An individual hardware component to which you 

send messages. Examples are: ALPHA SA signs, email, 
and pagers. All notification devices need notification 
device interfaces.

Notification Device Interface
Hardware with software settings needed to 

communicate properly with a hardware notification 
device. Please see “Appendix 3: Notification Device 
Interfaces” on page 96 for descriptions and examples.

Priority, Command
The level of authorization needed by a user to send a 

command to (or change a command for) a notification 
device. A lower number indicates more authority.

Priority, Running
The level of priority of a command sent to a 

notification device. A lower number indicates a higher 
priority. Each command has a priority. Messages with 
commands of the same priority are displayed on the 
notification device on a rotating basis. Messages with 
commands of a higher priority are displayed, while 
messages with commands of a lower priority are 
temporarily not displayed, until the messages with 
commands of a higher priority expire.

Single-user environment
A “single-user” environment in Smart Alec might 

have more than one user, but all users have full access 
rights to all applications, application functions, and 
system inputs and resources.

Update
If you have enough “update” authorization for an 

application, that application will also appear in the SA 
Bar for you. You will be able to view details and, in 
addition, you will be able to make changes using that 
application.
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User
Any person who is both authorized and set up to 

submit information in any way to Smart Alec.
Each user has not only a name and password, but 

also is authorized for applications, system resources, 
data, and processing.

Variable
A variable represents real-time (“as it happens”) data 

that can change (e.g., temperature or production rates, 
security lock status, alarms.) Since its value can change 
or vary, it’s called a “variable.” Variables’ values are 
typically acquired and handled by Smart Alec’s DDE or 
socket interfaces.

Variables can be used in two ways:
1. They can be embedded in messages. The value of 

the variable gets filled in wherever the variable is 
used in an active message, and it is refreshed 
whenever the value changes.

2. Variables can also be used to trigger commands 
for messages and events to start and stop.

As an example, you could have a variable called 
“Temperature” which is continually filled in with values 
from a thermometer. The variable could change, for 
instance, whenever there is at least a 1-degree change at 
the thermometer. Then, whenever “temperature” equals 
or exceeds 212° F, a message showing the temperature 
could be sent to a sign and an alarm could be triggered to 
sound.
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Purpose

The purpose of this appendix is to serve as a guide 
for a developer writing software to interface with the 
Smart Alec 2.1 system through the Socket Input Handler.

Definitions

• ASCII: American Standard Code for Information 
Interchange – A set of values corresponding to 
numbers, letters, symbols and codes for 
exchanging information.  Used in computing to 
send data across various lines of transmission.

• Null terminated string: A series of ASCII 
characters ending with a byte valued at 0.  This is 
similar to the standard implementation of a C++ 
character string class.

Theory of Operation

The Socket Input Handler is to be packaged with the 
first release of Smart Alec 2.1 as a direct interface into the 
system.  It is currently able to handle a Data Source 
Variable Change of State (COS) process.

The user connects to the socket handler using a 
standard socket implementation for any computer 
platform and the Port number found in the main Smart 
Alec database.  If the address and port are correct and the 
socket handler is running on the host computer, the 
handler will accept the connection. The system is 
designed to support unlimited users (from different or 
the same IP Address), as the host computer’s resources 
permit. 
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Login Sequence

1. Initiate a standard socket connection with the 
host computer using the IP Address of the host 
computer and the port number found in the 
Smart Alec database. 

2. The Smart Alec Socket Input Handler will accept 
the connection and log the IP address of the 
client system.

3. The client will send a ‘Login Packet’ described 
later in this document.

4. The Socket Input Handler will verify the login 
name and password with the database entries to 
determine if the client is a valid user.

5. If the user login is not valid, the Socket Input 
Handler will send an ‘Error Packet’ containing a 
message to that effect back to the client system.  
It will then immediately terminate the 
connection.

6. If the user login is valid, a ‘Success Packet’ will 
be returned to the client and operation will 
continue as normal.

Standard Operation

After a successful connection has been established, a 
valid user login has occurred and a ‘Success Packet’ has 
been returned, the Socket Input Handler sits in an idle 
state waiting for new packets to come in.

From there, the user is free to send new packets into 
the system at any time.  A packet is introduced into the 
system by sending data serially across the socket 
connection.  The elements of the packet are explained 
better later in the document, but the basic ordering is as 
follows:

• Class
• Subclass
• Message ID
• Priority
• Set of arguments
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After the packet has been introduced into the system, 
the Socket Input Handler parses the packet header for 
information on how to process the data.  The handler 
knows from the class and subclass how many arguments 
to look for and to where the packet needs to be routed.

Since the Socket Input Handler utilizes a 
synchronous transfer protocol, after each packet it 
receives, it responds to the client with either a ‘Success 
Packet’ or an ‘Error Packet.’  It is recommended, for the 
integrity of the system, that data is never sent from an 
individual source until a return packet has been received.

The Socket Input Handler was written using the 
MFC implementation of the CSocket class.  Because of 
this, it is important that regardless of the system the 
client computer is running, data being sent to the handler 
is sent in network byte order.  The issue comes about 
because manufacturers of different microchips have 
different views on how data should be stored in memory.  
For instance, a 32 bit DWORD on one system would be 
stored in the order: Byte 0 – 1 – 2 – 3, whereas another 
system might store it in the order: Byte 3 – 2 – 1 – 0.  
When it comes to networking, this issue has come about 
before.  Some implementations of sockets have the ability 
to take care of this.  If the developer notices that nothing 
is coming into the Socket Input Handler right, then there 
is a possibility that byte order is the issue.  MFC CSockets 
are set to read from ‘network byte order’ (“Big Endian”) 
and thus, so is this application.

General Packet Layout

The user sends information into the system serially 
as a packet.  The structure for all types of socket packets 
is as follows:

Name: Class
Type: long int (32 bits)
Description: Broad identifier for the type of mes-

sage packet
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Name: Subclass
Type: long int (32 bits)
Description: Specific identifier for the type of mes-

sage packet

Name: Message ID
Type: long int (32 bits)
Description: Used by client system to identify a 

message.  Upon response, the Mes-
sage ID will be identical to the ID of 
the packet being responded to.

Name: Priority
Type: short int (16 bits)
Description: Used internally by Smart Alec for rout-

ing priority. This feature is not cur-
rently implemented. Send a short int 
with a value of 0.

Name: Arguments
Type: Set of null terminated ( ‘\0’ ) ASCII 

character strings. All ASCII characters 
are valid except ASCII 0 ( ‘\0’ ).

Description: A set of null terminated strings of data.  
The strings are sent sequentially with 
only the null terminator in between.  
Each class and subclass has its own 
packet definition for number of strings 
to send and rules for format.

Data Source Variable COS
Description

This type of packet alters the value of a variable 
already existing in the Smart Alec system.  Typically, this 
is used to update a variable on a display device, give 
notice of an event, or display general information.
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Packet Definition
Class: 8
SubClass: 8
Arguments: 2 Arguments are expected for this type 

of message packet

Name: Var_Name
Limits: 32 characters
Description: Name of the variable as identified in 

the database

Name: Var_Cur
Limits: 128 characters
Description: Updated value of the variable (in null 

terminated string format)

Login Packet
Description

This is the first packet that needs to be sent into the 
system. If the login values to not match up with a user in 
the Smart Alec system, the Socket Input Handler will 
return an ‘Error Packet’ indicating an invalid login and 
the connection will be terminated.  If this is not the first 
packet sent, an ‘Error Packet’ will be returned indicating 
that the user is not logged in yet and the session will be 
terminated.  If a second login is attempted after a 
successful login has already occurred on this connection, 
an ‘Error Packet’ will be returned indicating that the user 
is already logged in and the session will continue. 

Packet Definition:
Class: 1
SubClass: 1

Arguments: 3 Arguments are expected for this type 
of message packet
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Name: User_Name
Limits: 64 characters
Description: The name used to identify the account 

of a Smart Alec user

Name: User_Password
Limits: 255 characters
Description: The password for this Smart Alec user 

account

Name: Callback_Port
Limits: Between 1024 and 65535 (in ASCII 

characters)
Description: The number of a port on the client’s 

system that has a listen connection 
open in the event of outstanding notifi-
cations after a broken connection.  In 
this case, the socket handler will open a 
socket to that port on the client’s sys-
tem.  This feature is not currently 
implemented. Send a null terminated 
string containing the number 0.  (ie. ‘0’ 
or ASCII 40)

Log Message
Description

This type of packet is primarily used as a diagnostic 
or debugging tool.  It will place a message or note 
directly into the Smart Alec Event Log, the Socket Input 
Handler local log file, and the Smart Alec Trace System.

Packet Definition
Class: 0
SubClass: 0

Arguments: 1 Argument is expected for this type of 
message packet
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Name: Message
Limits: 64 characters
Description: A message or note to place directly into 

the Smart Alec event log, the Socket 
Input Handler local log, and the Smart 
Alec event trace system.  Smart Alec 
will log this message regardless of 
whether logging or tracing is enabled.

Socket Command
Description

This type of packet is used to issue a command 
directly to the Socket Input Handler.  The scope of these 
commands is pretty limited, but can prove to be useful.  
The tools currently available are based on dynamically 
controlling tracing and logging.

Packet Definition
Class: 0
SubClass: 1

Arguments: 1 Argument is expected for this type of 
message packet

Name: Command
Limits: 32 characters (Case Insensitive)
Description: A control command to be issued 

directly to the Socket Input Handler

Available commands:
- None

Return Packets
These packets are returned upon completion of the 

processing of a submitted packet by the Socket Input 
Handler.  The packet format is the same as with packets 
sent into the socket handler.  The Message ID that comes 
back in this packet will be the same ID that was sent in 
the original packet.
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Success Packet
Description

The success packet is a return packet used in the 
synchronous transport protocol to indicate that a packet 
entered into the system has been processed by the socket 
handler and routed to its proper destination.  After 
receiving this packet, the client system is safe to send 
another packet.

Packet Definition
Class: 0
SubClass: 2

Arguments: 1 Argument is expected for this type of 
message packet

Name: Success Message
Limits: 32 characters
Description: A string indicating that processing is 

complete for a client’s message

Error Packet
Description

The error packet is returned when a problem has 
occurred either with the incoming packet or within the 
Socket Input Handler application.  The argument within 
the packet gives information on the nature of the error.  It 
is recommended that the client system examine the 
nature of the error and make a determination whether it 
should continue sending data.

Packet Definition
Class: 0
SubClass: 3
Arguments: 1 Argument is expected for this type of 

message packet

Name: Success Message:
Limits: 32 characters
Description: A string indicating nature of the error 

that the Socket Input Handler encoun-
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tered with this packet.  These errors are 
explained in the Return Information 
Reference.


